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PREFAȚĂ 

 

 

Prezentul ghid a fost întocmit pentru elaborarea și coordonarea proiectelor de diplomă ale 

studenților înscriși la specializarea Inginerie Urbană și Dezvoltare Regională (I.U.D.R) 

începând cu anul universitar 2023 – 2024.  
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Partea I: Alegerea temei proiectului de diplomă și a coordonatorului 

științific 

Întocmirea proiectului de diplomă se face sub îndrumarea unui coordonator științific care 

este un cadru didactic universitar de specialitate având titlul științific de doctor și gradul didactic 

de lector universitar, conferențiar universitar sau profesor universitar. Proiectul de diplomă poate 

fi îndrumat și de către un cadru didactic asociat cu titlu științific de doctor sau doctorand sau de 

către un cadru didactic titular cu gradul de asistent universitar având titlul științific de doctor sau 

doctorand numai în cotutelă cu un cadru didactic titular având gradul didactic de lector 

universitar, conferențiar universitar sau profesor universitar.  

Deoarece întocmirea proiectului de diplomă presupune o perioadă îndelungată de 

documentare, efectuare calcule și redactare, studenții au obligația de a-și alege în timp util tema 

proiectului de diplomă și coordonatorul științific.  

Până la data de 15 noiembrie a anului final de studiu, studenții sunt obligați să depună 

la secretariatul Departamentului de Cadastru, Inginerie Civilă și Ingineria Mediului o cerere în 

care se specifică titlul temei proiectului de diplomă și numele coordonatorului științific. Cererea 

este avizată de către coordonatorul științific ales.  

La alegerea temei proiectului de diplomă trebuie avute în vedere posibilitățile de 

documentare teoretică și de cooperare practică concretă, dar și intențiile de viitor oferite de 

oportunitățile de angajare pe piața muncii. Tema proiectului de diplomă trebuie să reflecte 

apartenența studentului la specializarea parcursă în perioada universitară. 

Lista temelor propuse poate fi consultată pe site-ul Facultății de Informatică și Inginerie. 

Lista temelor nu este restrictivă. Studenții pot propune și alte teme specifice specializării 

Inginerie Urbană și Dezvoltare Regională, urmând ca acestea să fie definitivate cu acordul 

coordonatorilor științifici.  

Confirmarea alegerii titlului și a coordonatorului se face prin completarea cererii de 

coordonare proiect de diplomă de la Anexa nr. 8 în două exemplare, semnate de student și de 

coordonatorul științific.  

Coordonatorul științific răspunde de informarea și îndrumarea studenților/absolvenților 

cu privire la modalitatea de întocmire și susținere a proiectelor de diplomă. 
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Partea a II-a: Structura proiectului de diplomă 

Proiectul de diplomă va conține o parte scrisă și un set de piese desenate specifice.  

Proiectul de diplomă este structurat pe capitole și cuprinde următoarele elemente 

obligatorii: 

1. Coperta proiectului de diplomă 

Informațiile care trebuie menționate pe coperta proiectului de diplomă sunt prezentate în 

Anexa nr. 2.  

Coperta va fi cartonată în mod obligatoriu. Nu sunt admise proiecte de diplomă 

spiralate sau sub alte forme de prezentare! 

2. Pagina de titlu 

Informațiile care trebuie menționate în pagina de titlu a proiectului de diplomă sunt 

prezentate în Anexa nr. 3.  

3. Cuprinsul 

Proiectul de diplomă va avea un cuprins care să conțină cel puțin titlurile tuturor 

capitolelor însoțite de numărul paginii la care începe fiecare capitol. În Anexa nr. 4 este 

prezentat un model de realizare a cuprinsului.  

4. Introducere 

Introducerea va conține motivația alegerii temei, locul de realizare a temei, metode și 

mijloace noi folosite în realizarea temei, metodologia de cercetare folosită, structura proiectului 

de diplomă – titlul capitolelor și legătura dintre ele, eventualele limite ale proiectului 

(confidențialitatea datelor, lipsa accesului la unele surse bibliografice etc.).  

Introducerea nu se numerotează ca și capitol.  

5. Capitole 

Proiectul de diplomă va conține minim 3 capitole numerotate crescător, fiecare putând 

să aibă, în partea finală, o secțiune de concluzii, care să sintetizeze informațiile și/sau rezultatele 

prezentate în cadrul acelui capitol. Se recomandă o dimensionare optimă a structurii proiectului 

de diplomă, astfel încât să se evite, pe de o parte, segmentarea excesivă a materialului elaborat, 

iar pe de altă parte, realizarea unor capitole supradimensionate. U 

În Capitolul I va fi descrisă tema proiectului de diplomă privind localizarea geografică a 

obiectivului, descrierea obiectivului și structura proiectului.  

Începând cu Capitolul II, proiectul de diplomă este structurat în două părți astfel:  
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a) Partea de Inginerie Urbană și Dezvoltare Regională. 

b) Partea de Structuri.  

Fiecare parte va fi coordonată de către un cadru didactic de specialitate.  

6. Concluzii și propuneri 

În această parte se regăsesc cele mai importante concluzii ale proiectului de diplomă, 

opinia personală privind rezultatele obținute, precum și potențiale direcții viitoare de cercetare 

legate de tema abordată. 

7. Tabele 

Tabelele se inserează, se denumesc și se numerotează corespunzător capitolului aferent. 

Mai multe detalii sunt prezentate în Partea a III-a prezentului ghid.   

8. Piese desenate 

Pentru fiecare parte a proiectului de diplomă, în funcție de tema abordată, se vor redacta 

următoarele piese desenate: 

a) Partea de Inginerie Urbană și Dezvoltare Regională: încadrarea în teritoriu, 

analiza funcțională, zone prioritare de intervenție cu localizarea proiectelor,  

analiza funcțională, plan de amplasare în zonă, planuri speciale, profile 

longitudinale, profile transversale etc. 

b) Partea de Structuri: planuri de arhitectură, planuri poziționare generala a 

elementelor structurale în plan și elevație, planuri cu detalierea elementelor 

structurale principale.  

Piesele desenate se vor redacta la scările specifice și vor avea chenar și indicator. 

Chenarul și indicatorul se trasează după regulile prezentate în Partea a III-a. Indicatorul se 

completează după instrucțiunile prezentate în Anexa nr. 7.   

9. Anexele 

Anexele nu se numerotează ca și capitol, fiecare fiind menționată cel puțin o dată în 

textul lucrării. Anexele se numerotează crescător pentru toată lucrarea astfel: Anexa 1, Anexa 2 

etc.  

10. Borderoul de piese desenate 

Proiectul de diplomă va conține un borderou cu lista pieselor desenate care va fi atașat la 

finalul părții scrise. Borderoul de piese desenate nu se va numerota ca și capitol. În Anexa nr. 6 

este prezentat un model de borderou de piese desenate.  
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11. Bibliografia 

Bibliografia va conține lista tuturor surselor de informație utilizate de către absolvent 

pentru întocmirea proiectului de diplomă. Bibliografia nu se va numerota ca și capitol. În Partea 

a III-a și în Anexa nr. 5 este prezentat un exemplu de organizare al bibliografiei.  

12. Curriculum Vitae 

Absolventul va atașa un Curriculum Vitae la finalul părții scrise al proiectului de diplomă. 

Curriculum Vitae va fi în format Europass.  
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Partea a III-a: Reguli de redactare a proiectului de diplomă 

Acest capitol cuprinde regulile de redactare a părții scrise a proiectului de diplomă și 

regulile de redactare a pieselor desenate.  

1. Reguli de redactare a părții scrise 

Partea scrisă a proiectului de diplomă se va redacta pe format A4. Imprimarea foilor se 

face doar pe 1 singură față. 

1.  Marginile paginii 

Marginile paginii vor avea următoarele dimensiuni (Page Layout → Custom Margins): 

• Stânga: 2,5 cm; 

• Dreapta: 2 cm; 

• Sus: 2 cm; 

• Jos: 2 cm; 

• Antet: 1,25 cm; 

• Subsol: 1,25 cm. 

2.  Spațiere între rânduri 

Textul se va redacta cu spațiu de 1,5 între rânduri (Paragraph → Indents and Spacing → 

Line Spacing).   

3. Alinierea textului   

Textul din cadrul paragrafelor normale va fi aliniat între marginile din stânga şi dreapta 

(Justified). Primul rând al fiecărui paragraf va avea o indentare de 1,25 cm (Paragraph → 

Indents and Spacing → Indentation → Special → First line by 1,25 cm).  Excepţie fac titlurile 

capitolelor, etichetele tabelelor și etichetele figurilor care vor fi aliniate centrat. 

Titlurile capitolelor se vor scrie bold, centrat cu litere mari. Titlurile paragrafelor se vor 

scrie cu bold, centrat cu litere mici. Se lasă câte un rând liber între titlurile capitolelor, 

paragrafelor și corpul textului.  

În corpul textelor nu trebuie să abunde sublinierea, boldarea sau scrierea cu caractere 

italic a textului. 

4. Font 

Fontul utilizat pentru redactare va fi Times New Roman, cu dimensiunea de 12 puncte, 

utilizând diacriticele specifice limbii române (ă, ş, ţ, î, â). 



9 

 

5. Numerotarea paginilor 

Numerotarea paginilor se face începând cu primul capitol până la ultima pagină a 

proiectului, exceptând anexele. Numărul de pagină se inserează în subsolul paginii, centrat 

(Insert → Page Number → Bottom of Page → Plain Number 2). 

6. Tabele 

Tabelele se numerotează cu 2 cifre, prima reprezentând numărul capitolului, iar cea 

de a doua reprezentând numărul tabelului din capitolul respectiv. Fiecare tabel are titlu, care 

se menţionează deasupra tabelului aliniat centrat şi un număr aliniat la marginea din dreapta. 

Dacă este cazul, sursa datelor se precizează sub tabel, aliniat între marginile din stânga şi dreapta 

(Justified), indicând în mod obligatoriu numele autorului(lor), lucrarea (cartea), editura, anul, 

pagina sau adresa de Internet completă.  

Mai jos este prezentat un exemplu de introducere a tabelelor în partea scrisă a proiectului 

de diplomă: 

 

Tabel 2.1: Evaluarea încărcărilor permanente ale elementelor de construcție.  

Elementul 

de 

construcție 

Nr. 

crt.  

Numele 

stratului 

de finisaj 

Grosimea 

(m) 

Greutatea 

specifică 

(kN/m3) 

Încărcarea 

normalizată 

(kN/m2) 

Coeficientul 

parțial de 

siguranță 

pentru 

încărcări 

permanente 

γG 

Valoarea 

de calcul 

(kN/m2)  

     

Încărcarea se 

distribuie pe 

suprafață astfel: 

grosime×greutatea 

specifică.  

1,35 

Se 

înmulțește 

încărcarea 

normalizată 

cu 

coeficientul 

parțial de 

siguranță. 

 

7. Figuri 

Figurile (imagini, grafice, capturi de ecran) se numerotează cu 2 cifre, prima 

reprezentând numărul capitolului, iar cea de a doua fiind numărul figurii din capitolul 

respectiv. Fiecare figură are număr şi titlu, care se menţionează sub figură, centrat. Dacă este 

cazul, sursa figurii se indică pe rândul imediat următor, aliniat între marginile din stânga și 

dreapta (Justified), indicând numele autorului(lor), lucrarea (cartea), editura, anul, pagina sau 

adresa de Internet completă.  



10 

 

Mai jos este prezentat un exemplu de introducere a figurilor în partea scrisă a proiectului 

de diplomă: 

 

Figura 2.2: Coeficientul aerodinamic de presiune/sucțiune pe suprafețele exterioare ale clădirii.  

8. Ecuații matematice 

Ecuațiile matematice se vor scrie într-un editor de ecuații special precum MathType 6.0 

Equation sau Microsoft Equation 3.0. Ecuațiile matematice se introduc în text astfel: Insert → 

Object → Microsoft Equation 3.0 sau Insert → Object → MathType 6.0 Equation. Ecuațiile 

matematice se scriu cu font Times New Roman, dimensiunea de 12 puncte, cu caractere 

Italic.  

9. Note de subsol 

În situaţia în care se citează se vor introduce note de subsol (Insert → Footer) pentru a se 

indica sursa(ele). Acestea se numerotează unitar pentru toată lucrarea. 

10. Bibliografia 

Bibliografia proiectului de diplomă se structurează în următoarele categorii: materiale 

tipărite (cărţi şi lucrări de autor în edituri, studii şi articole în reviste de specialitate sau 

prezentate la conferinţe), resurse în format electronic (articole şi lucrări conferinţe disponibile 

on-line, site-uri consultate), documente elaborate de diferite organisme şi instituţii şi acte 

normative. Aceste liste bibliografice se vor ordona alfabetic şi vor respecta următoarele reguli 

de redactare: 

• Cărți cu unul/mai mulți autori: Nume autor(i), „Titlul cărții”, editura, locul apariției, 

anul apariției.  

• Articol din revistă în format tipărit: Nume autor(i), „Titlul articolului”, Titlul 

revistei, numărul revistei, luna și anul apariției, paginile unde se află articolul. 
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• Documente ale unor instituții: Numele instituției, „Documentul/Regulamentul”, anul 

apariției, locul, paginile unde se află documentul sau adresa site-ului. 

• Articol din revistă în format on-line:  Nume autor(i), „Titlul articolului”, Titlul 

revistei, numărul revistei, luna și anul apariției, paginile unde se află articolul, adresa 

site-ului.  

2. Reguli de redactare a pieselor desenate 

Toate piesele desenate ale proiectului de diplomă vor conține obligatoriu chenar și 

indicator.  

Trasarea chenarului se face astfel (a se vedea figura de mai jos): la 2 cm față de marginea 

din stânga și la 1 cm față de marginile de sus, din dreapta și respectiv de jos. Linia chenarului 

este de grosime mare. Indicatorul se așează în colțul din dreapta jos a chenarului. Conturul 

indicatorului se trasează cu linie de grosime mare.  

 

Piesele desenate de la partea de Structuri a proiectului de diplomă se vor numerota astfel: 

• Planșele de arhitectură: A1, A2, A3, etc. 

• Planșele elementelor structurale: R1, R2, R3, etc.  

Piesele desenate trebuie să respecte regulile de redactare a planșelor pentru urbanism 

(culori convenționale, scări, cote, linii de indicație, direcția nordului, etc.) și, respectiv a 

planșelor pentru desenul tehnic de construcții (grosimi de linii, scriere tehnică, scări, cote, linii 

de indicație, hașuri, etc.).   

Indicatorul se va trasa și completa după instrucțiunile de la Anexa nr. 7.  
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Partea a IV-a: Aspecte legate de etică și integritate academică 

Plagierea reprezintă însușirea integrală sau parțială a unei opere literare, artistice sau 

științifice a unui alt autor și prezentată acesteia drept creație personală. 

Tipurile de plagiat pot fi următoarele: 

1. Copierea integrală 

În cazul copierii integrale se prezintă capitole sau pasaje întregi dintr-o altă lucrare după 

tehnica copiere-lipire (Copy – Paste), pretinzând că acestea ar fi creație proprie. Copierea 

parțială 

Acest tip de plagiat presupune copierea câtorva rânduri, a unor paragrafe sau părți 

semnificative, lungi de câteva pagini, dintr-o lucrare.  

2. Copierea prin parafrazare 

În cazul copierii prin parafrazare, se preiau structura, linia de argumentare, exemplele și 

alte elemente de conținut ale sursei, însă se modifică formulările, succesiunea paragrafelor sau 

alte elemente pentru a face mai dificilă identificarea autorului original. 

3. Autoplagierea  

Autoplagierea presupune expunerea într-o operă scrisă sau o comunicare orală, inclusiv 

în format electronic, a unor texte, expresii, demonstrații, date, ipoteze, teorii, rezultate ori metode 

științifice extrase din opere scrise, inclusiv în format electronic, ale aceluiași autor sau acelorași 

autori, fără a menționa acest lucru și fără a face trimitere la sursele originale. 

Pentru evitarea plagiatului în redactarea proiectelor de diplomă, absolvenții trebuie să țină 

cont de următoarele: 

• Studenții/absolvenții trebuie să conceapă un proiect de diplomă original din care să 

rezulte în mod cât mai clar propriile contribuții, ce vor fi evaluate de către comisia de 

examinare. 

• Studenții/absolvenții trebuie să precizeze în Bibliografie sursele utilizate în proiectul de 

diplomă. 

• Specificarea precisă a autorului și a sursei prin citare.  

• Evitarea formulărilor de tipul „este cunoscut faptul”, „alți cercetători au arătat”, 

„există autori care afirmă”, „se știe că”. Într-o lucrare științifică precum proiectul de 

diplomă trebuie precizat exact cine este autorul conceptelor, argumentelor, formulărilor 

enunțate. 
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Înainte de înscrierea la examenul de finalizare a studiilor de licență, proiectele de diplomă 

ale absolvenților vor fi verificate cu ajutorul sistemelor anti-plagiat. În urma verificării anti-

plagiat, cadrul didactic responsabil va întocmi un raport de similitudini care va fi trimis 

conducătorului științific. În funcție de rezultatul raportului de similitudini, conducătorul științific 

decide dacă proiectul de diplomă poate fi susținut în fața comisiei de examinare.  
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Partea a V-a: Reguli de prezentare a proiectului de diplomă 

Prezentarea proiectului de diplomă în faţa comisiei de examinare este la fel de importantă 

ca redactarea acestuia. Nota finală obţinută de către absolvent reprezintă atât rezultatul evaluării 

proiectului de către coordonatorul științific (evaluare consemnată în referatul de apreciere semnat 

în original), cât şi rezultatul evaluării comisiei de examinare în urma susţinerii acestuia de către 

absolvent.  

1. Referatul de apreciere al coordonatorului științific 

În referatul de apreciere, coordonatorului științific evaluează obiectiv activitatea 

studentului pe parcursul întocmirii proiectului de diplomă. Criteriile de evaluare a proiectului de 

diplomă sunt prezentate în detaliu în Partea a VI-a. Referatul de apreciere semnat în original de 

către coordonatorul științific va fi transmis secretarului comisiei de finalizare a studiilor.  

Un proiect de diplomă neînsoțit de referatul de apreciere al conducătorului științific 

nu poate fi susținut în faţa comisiei.  

În Anexa nr. 1 este prezentat un model de referat de apreciere.  

2. Programarea examenului de diplomă 

Absolvenții vor fi anunțați în legătură cu data, ora și locul desfășurării examenului de 

diplomă. De asemenea, absolvenții vor fi informați și în legătură cu componența comisiei de 

examinare.  

Neprezentarea absolventului la data, ora și locația stabilite atrage eliminarea 

acestuia din examenul de diplomă.  

3. Prezentarea proiectului de diplomă 

Prezentarea proiectului de diplomă se face în mod liber alături de piesele desenate expuse 

într-o prezentare PowerPoint. În prezentarea PowerPoint, absolventul va insera piesele desenate 

în ordinea în care apar în borderoul atașat proiectului de diplomă.  

Absolventul va avea asupra lui și piesele desenate în format tipărit așezate într-un tub în 

cazul în care comisia de examinare dorește să le consulte în detaliu.  

4. Timpul maxim de prezentare 

Timpul alocat prezentării va fi de maxim 15 minute.  

5. Întrebări ale comisiei de examinare 

Membrii comisiei de examinare vor adresa absolventului întrebări referitoare la tema 

proiectului de diplomă și/sau metodologia și resursele folosite. 
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Reguli de realizare a prezentării PowerPoint: 

• Prezentarea va conține minim 20 de slide-uri.  

• În cele minim 20 de slide-uri, prezentarea va include obligatoriu următoarele: 

1. Un slide de titlu care va conține următoarele elemente: titlul proiectului de diplomă, 

numele și prenumele absolventului, gradul didactic, titlul științific, numele și 

prenumele coordonatorului științific.  

2. Un slide cu introducerea în tema proiectului de diplomă.  

3. Slide-urile cu piesele desenate ordonate în ordinea de pe borderoul atașat părții scrise 

a proiectului de diplomă. 

4. 1-2 slide-uri cu concluzii și propuneri.  

Absolventul nu va citi informația de pe prezentarea PowerPoint.  
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Partea a VI-a: Criteriile de evaluare a proiectului de diplomă 

1. Importanța și complexitatea temei 

Tema proiectului de diplomă trebuie să reflecte apartenenţa absolventului la domeniul de 

studiu parcurs în perioada universitară. Fundamentarea teoretică a temei propuse este dată de 

următorii factori: relevanţa reperelor teoretice alese, utilizarea riguroasă a conceptelor, ideilor, 

teoriilor, diversitate bibliografică. 

2. Actualitatea temei 

 Informaţiile prezentate în proiectul de diplomă trebuie să corespundă momentului actual, 

să fie abordate şi în alte lucrări de cercetare și să fie tratate cu responsabilitate şi competenţă. De 

asemenea, acestea trebuie să facă referire la gradul de acoperire al subiectului tratat și la cât de 

explicit este prezentat şi structurat acesta. 

Se apreciază redactarea lucrării într-un limbaj științifico-tehnic, nu sunt admise greşelile 

gramaticale și de redactare, iar ideile prezentate trebuie să decurgă logic şi coerent. 

3. Adecvarea structurii proiectului la tema aleasă 

Pentru uşurinţa tratării, tema trebuie să fie structurată pe mai multe capitole 

corespunzătoare unor idei de bază din domeniul abordat. Capitolul prezintă ideea respectivă în 

detaliu. Ideile trebuie să fie formulate într-un limbaj ştiinţific și tehnic adecvat, în concordanţă cu 

standardele formale impuse şi într-o manieră logică. 

În apreciere se va considera organizarea logică în capitole în funcție de specificul temei 

proiectului de diplomă. Este apreciată numerotarea clară a capitolelor şi subcapitolelor pentru a 

indica gradul de generalitate a unui aspect sau altul al lucrării cu respectarea structurii cadru a 

proiectului de diplomă. 

Ordonarea capitolelor trebuie să permită verificarea următoarelor elemente fundamentale: 

pregătirea teoretică, pregătirea metodologică, capacitatea de a efectua o aplicaţie practică în 

domeniul abordat, capacitatea de a interpreta rezultate şi de a formula propuneri de perfecţionare 

în domeniul abordat.  

4. Elaborarea lucrării (documentare, ritmicitate, participare la întâlniri cu 

conducătorul) 

La proiectul de diplomă documentarea se realizează prin inventarierea şi consultarea 

datelor, informaţiilor, planurilor şi hărţilor din zonă, lucrări anterioare executate, prin cărţi de 
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specialitate, documente oficiale, legislaţie, reviste şi publicaţii de specialitate sau site-uri cu 

relevanţă pentru tema proiectului de diplomă. 

 Absolventul va elabora și prezenta coordonatorului științific un plan de proiect orientativ 

și o listă sumară cu resursele bibliografice relevante tematicii și subiectului propus. 

Coordonatorul științific poate impune absolventului un calendar al consultațiilor și are sarcina de 

a monitoriza activitatea acestuia. Absolventul trebuie să respecte, pe parcursul elaborării și 

prezentării proiectului de diplomă, cerințele impuse de coordonator. Redactarea se va face în 

limba predominantă a programului de studiu urmat. Aceasta trebuie să respecte standardele de 

tehnoredactare și de citare enunțate în prezentul ghid. 

5. Originalitate (aport personal și contribuții) 

Se apreciază capacitatea de raportare la sursele teoretice şi de promovare a unei viziuni 

proprii asupra temei abordate, interpretarea datelor obținute, susţinerea unui punct de vedere sau 

deschiderea unei direcţii de dezbatere semnificative în raport cu tema abordată. 

6. Aplicație practică/studiu de caz (calitate, relevanță) 

Se apreciază existenţa şi modalitatea de redactare a documentaţiei aferente aplicațiilor 

practice și studiilor de caz. În acest caz se va avea în vedere ca documentaţia grafică aferentă 

studiului de caz să fie întocmită la o scară convenabilă care să permită citirea rapidă a planurilor, 

fiind întocmită în conformitate cu legislaţia în vigoare. În cazul abundenţei unor elemente în 

redactarea documentației grafice, acestea vor fi înlocuite prin semne convenţionale, conform 

Atlasului de Semne Convenţionale. 

7. Conținutul științific al lucrării (abordare metodologică, aplicabilitate) 

Se apreciază existența unei metodologii adecvate în redactarea proiectului de diplomă, în 

funcție de tema aleasă.  Astfel, se punctează selectarea celor mai bune metode de investigație 

prin deplasarea în teren și de prelucrare a datelor în funcție de studiile de caz alese.  De 

asemenea, este importantă alegerea inspirată a studiilor de caz, din punct de vedere al 

aplicabilității practice pe care acestea le vor demonstra. 

8. Tehnoredactare (estetică și ținută grafică, ordonarea textului, respectarea normelor 

ortografice și de tehnoredactare recomandate) 

Proiectul de diplomă se prezintă sub aspect îngrijit, tehnoredactarea fiind realizată cu 

semne diacritice, fără greşeli ortografice. Se apreciază existenţa şi modalitatea de redactare a 

surselor informaţionale (note de subsol, surse la tabele, figuri, etc.). 
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9. Bibliografie (adecvare, amploare) 

Bibliografia trebuie să fie cât mai cuprinzătoare şi să conţină surse bibliografice de 

actualitate. Absolventul trebuie să cunoască şi să facă referiri la principalele surse de informaţie 

în domeniul temei proiectului de diplomă. La notare se vor lua în calcul doar sursele 

bibliografice strâns legate de tema abordată. 

Proiectul de diplomă trebuie să conţină referinţe bibliografice în cadrul capitolelor, 

inserate în text sau abordate ca note de subsol după caz, şi nu doar la finalul acestuia. Aceste 

referinţe bibliografice arată modul în care absolventul a studiat tema proiectului în literatura de 

specialitate sau în alte surse de informare adecvate. Vor fi luate în calcul la notare acele referinţe 

bibliografice din cadrul textului care întrunesc condiţii de oportunitate şi adecvare la conţinutul 

lucrării. 

Bibliografia de la finalul părții scrise a proiectului de diplomă şi referinţele bibliografice 

trebuie redactate conform regulilor enunţate în prezentul ghid. 

10.Concluzii și propuneri (nivel calitativ, elemente originale) 

Se apreciază modul în care absolventul a derulat cercetarea pentru întocmirea proiectului 

de diplomă pe intervale de timp, stadii sau faze caracterizate, de obicei, prin evenimente 

importante, precum: finalizarea fiecărui capitol, asamblarea lucrării, formularea concluziilor şi 

propunerilor etc. 

La proiectul de diplomă este obligatoriu să existe un capitol distinct care să conțină 

concluzii și propuneri. Absolventul va enunța aici cele mai importante concluzii din proiect, 

opinia personală privind rezultatele obținute, precum și potențialele direcții de dezvoltare și 

cercetare pentru viitor pe care tematica abordată le prezintă. Se recomandă ca acest capitol să se 

remarce prin elemente originale și un nivel calitativ superior demonstrat prin relevanța actuală și 

de perspectivă a studiului de caz și prin valoarea reală a ideilor oferite de către absolvent. 

  



19 

 

Anexa nr. 1: Model referat de apreciere al coordonatorului științific 

 

UNIVERSITATEA ”1 DECEMBRIE 1918” DIN ALBA IULIA 

FACULTATEA ______________________________________ 

SPECIALIZAREA_____________________________________________________________________________ 

FORMA DE ÎNVĂȚĂMÂNT (se exclude varianta incorectă) ZI / ID 

SESIUNEA DE LICENȚĂ / DIPLOMĂ / DISERTAȚIE (se exclud variantele incorecte)  

Perioada_____________ 

 

REFERAT (FIȘA DE APRECIERE) DE EVALUARE SINTETICĂ A CALITĂȚII 

LUCRĂRII DE LICENȚĂ / DIPLOMĂ / DISERTAȚIE 
 

Absolvent (a):________________________________________________________________________________ 

Tema lucrării:_________________________________________________________________________________ 

Conducător științific:__________________________________________________________________________ 

 

Nr. crt. CRITERIUL  CUANTIFICARE  
(se încercuiește nota acordată, pentru fiecare criteriu) 

1 Importanța și complexitatea temei 1  2  3  4  5  6  7  8  9  1 0  
2 Actualitatea temei 1  2  3  4  5  6  7  8  9  1 0  
3 Adecvarea structurii lucrării la tema 

aleasă 
1  2  3  4  5  6  7  8  9  1 0  

4 Elaborarea lucrării (documentare, 

ritmicitate, participare la întâlniri cu 

conducătorul) 

1  2  3  4  5  6  7  8  9  1 0  

5 Originalitate (aport personal și contribuții) 1  2  3  4  5  6  7  8  9  1 0  
6 Aplicație practică / studiu de caz (calitate, 

relevanță) 
1  2  3  4  5  6  7  8  9  1 0  

7 Conținutul științific al lucrării (abordare 

metodologică, aplicabilitate) 
1  2  3  4  5  6  7  8  9  1 0  

8 Tehnoredactare (estetică și ținută grafică, 

ordonarea textului, respectarea normelor 

ortografice și de tehnoredactare recomandate) 

1  2  3  4  5  6  7  8  9  1 0  

9 Bibliografie (adecvare, amploare) 1  2  3  4  5  6  7  8  9  1 0  
10 Concluzii și propuneri (nivel calitativ, 

elemente originale) 
1  2  3  4  5  6  7  8  9  1 0  

Nota finală (Media notelor criteriilor)  
 

Concluzii: Propun admiterea/respingerea (se elimină varianta incorectă) lucrării de 

licență/diplomă/disertație (se elimină variantele incorecte) pentru a fi prezentată în fața comisiei 

examenului de finalizare a studiilor. 

 

Nota propusă de conducătorul științific: ________________ 
    

DATA                                                            COORDONATOR  ȘTIINȚIFIC 
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Anexa nr. 2: Coperta cartonată a proiectului de diplomă 

 

MINISTERUL EDUCAȚIEI ȘI CERCETĂRII 

UNIVERSITATEA „1 DECEMBRIE 1918” DIN ALBA IULIA 

FACULTATEA DE INFORMATICĂ ȘI INGINERIE 

SPECIALIZAREA „INGINERIE URBANĂ ȘI DEZVOLTARE REGIONALĂ” 

FORMA DE ÎNVĂȚĂMÂNT ZI 

 

 

 

 

 

 

 

 

PROIECT DE DIPLOMĂ 

 

 

COORDONATOR, ABSOLVENT, 

(Se trec gradul didactic, titlul științific, 

numele și prenumele coordonatorului 

proiectului de diplomă) 

(Se trec numele și prenumele 

absolventului) 

 

                                      

 

 

ALBA IULIA  

2025  
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Anexa nr. 3: Pagina de titlu a proiectului de diplomă 

 

MINISTERUL EDUCAȚIEI ȘI CERCETĂRII 

UNIVERSITATEA „1 DECEMBRIE 1918” DIN ALBA IULIA 

FACULTATEA DE INFORMATICĂ ȘI INGINERIE 

SPECIALIZAREA „INGINERIE URBANĂ ȘI DEZVOLTARE REGIONALĂ” 

FORMA DE ÎNVĂȚĂMÂNT ZI 

 

 

 

 

 

 

TITLUL PROIECTULUI DE 

DIPLOMĂ 

 

 

COORDONATOR, ABSOLVENT, 

(Se trec gradul didactic, titlul științific, 

numele și prenumele coordonatorului 

proiectului de diplomă) 

(Se trec numele și prenumele 

absolventului) 

 

                        

 

 

 

ALBA IULIA  

2025  
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Anexa nr. 4: Exemplu de cuprins 

 

CUPRINS* 
 

 
CAPITOLUL 1: TITLUL CAPITOLULUI ....................................................................................1 

 1.1. Titlu subcapitol ............................................................................................................1 

  1.1.1. Titlu paragraf ............................................................................................... 1 

  1.1.2. Titlu paragraf ................................................................................................3 

 1.2. Titlu subcapitol ............................................................................................................5 

  1.2.1. Titlu paragraf ............................................................................................... 5 

  1.2.2. Titlu paragraf ................................................................................................7 

CAPITOLUL 2: TITLUL CAPITOLULUI ..................................................................................10 

 2.1. Titlu subcaptiol ..........................................................................................................10 

  2.1.1. Titlu paragraf ..............................................................................................11 

etc. 

CONCLUZII..................................................................................................................................68 

BIBLIOGRAFIE ...........................................................................................................................70 

ANEXE .........................................................................................................................................73 

 

*Această structură a cuprinsului este orientativă. În funcție de tema abordată, fiecare 

proiect de diplomă va avea propriile lui titluri de capitole, subcapitole și paragrafe. 
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Anexa nr. 5: Exemplu de bibliografie 

 

BIBLIOGRAFIE* 
 

Cărți cu unul/mai mulți autori 

1. Gabriel Iulian Mihai, „Îndrumător pentru proiectarea clădirilor cu acoperișuri de tip 

șarpantă din lemn”, Editura Matrixrom, București, 2015. 

2. Horia-A. Andreica, Constantin Munteanu, Ioana Mureșanu, Ligia Mihaela Moga, Roxana 

Tămaș-Gavrea. „Construcții civile I”. Editura U.T. Press, Cluj-Napoca, 2009. 

3. Zoltan Kiss, Traian Oneț. „Proiectarea structurilor de beton după SR EN 1992-1”. 

Editura Abel, Cluj-Napoca, 2008. 

 

Norme de proiectare 

1. SR EN 1990. Eurocod 0: „Bazele proiectării structurilor”. 

2. NP 112 – 2013. „Normativ privind proiectarea fundațiilor de suprafață”. 

3. NP 005-2003: „Proiectarea construcțiilor din lemn”. 

4. P 118-99. „Normativ de siguranță la foc a construcțiilor”. 

5. SR EN 1991-1-1. Eurocod 1: „Acțiuni asupra structurilor”. Partea 1-1: „Acțiuni 

generale – Greutăți specifice, greutăți proprii, încărcări utile pentru clădiri”. 

 
*Această structură a bibliografiei este orientativă. În funcție de tema abordată, fiecare 

proiect de diplomă va avea propria lui bibliografie. 
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Anexa nr. 6: Exemplu de borderou piese desenate 

 

BORDEROU PIESE DESENATE* 

 

Planșe de arhitectură: 

A1. PLAN PARTER, Scara 1:50 

A2. PLAN ETAJ, Scara 1:50 

A3. PLAN ACOPERIȘ, Scara 1:50 

A4. FAȚADE, Scara 1:100 

A5. SECȚIUNE A-A, Scara 1:50 

A6. SECȚIUNE B-B, Scara 1:50 

Planșe de rezistență: 

R1. PLAN COFRAJ PLANȘEU COTA +2,75 m, Scara 1:50. 

R2. PLAN ARMARE PLANȘEU COTA +2,75 m, Scara 1:50. 

R3. PLAN COFRAJ-ARMARE GRINDĂ PRINCIPALĂ COTA +2,70 m, Scara 

1:50. 

R4. PLAN COFRAJ-ARMARE STÂLP, Scara 1:20, 1:50.  

R5. PLAN FUNDAȚII, Scara 1:50. 

R6. DETALII FUNDAȚII, Scara 1:20.  

 

*Această structură a borderoului de piese desenate este orientativă. În funcție de tema 

abordată, fiecare proiect de diplomă va avea propriul lui borderou de piese desenate. 
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Anexa nr. 7: Model de completare a indicatorului pentru planșe 

 

 

 

Indicatorul este adaptat planșelor pentru proiectul de diplomă și se va completa după cum 

urmează: 

1 – Numele instituției: Universitatea „1 Decembrie 1918” din Alba Iulia, Facultatea de 

Informatică și Inginerie; 

2 – Specializarea și sesiunea de examinare: Inginerie Urbană și Dezvoltare Regională, 

Proiect de diplomă, Sesiunea Iunie 2024; 

3 – Indicativul proiectului: „D” de la „diplomă”;  

4 – Scara/scările la care au fost redactate desenele: de exemplu, 1:50;  

5 – Titlul piesei desenate: de exemplu „Plan cofraj-armare grindă principală cota 

+2,80 m”;  

6 – Numărul de ordine al planșei: de exemplu A1, A2, etc. 
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Anexa nr. 8: Cerere coordonare proiect de diplomă 

 

Facultatea de Informatică și Inginerie 

Departamentul de Cadastru, Inginerie Civilă și Ingineria Mediului   
 

 

 

                                                                                              De acord cu îndrumarea, 

Cadru didactic coordonator:  ……………………………………………………  

                                                                                            Semnătura ………………………  
 

 

      CERERE 
 

Subsemnatul(a),   , student(ă) 

în  anul     ,  specializarea     ,  vă  rog  

să-mi aprobaţi realizarea proiectului de diplomă  cu titlul     
 

 
 
 

   ,  

pentru sesiunea . 

 

 
Semnătură student 

 
 

Alba Iulia 
 

Data    
 
 
 
 

 


